
[Optical Disc Archive Software]            29/Sep/2023 

 Optical Disc Archive Software Ver 5.5.1 is released. 

 

[Additional Items in Ver5.5.1] 

Windows 

1. Optical Disc Archive Filer supports to transfer the entire of one Optical Disc Archive cartridge 

to the PC local storage and the storage device with SMB I/F supported. 

2. Optical Disc Archive Utility has checked whether the transfer size of the Fibre Channel Host Bus 

Adapter card is appropriately set when starting up.  

3. After applying the latest cumulative update on Windows 11/10, you can not write correctly on the 

Optical Disc Archive Cartridge from other than our recommended applications such as Optical Disc 

Archive Filer or File Manager, but this time, this software is improved and it have write correctly 

from Windows Explorer, etc.  

4. Modified the Optical Disc Archive Filer so that even if the setting when transferring files or 

folders fails is set to " Discontinue immediately", It is available to transfer files to another 

cartridge when the remaining space of the cartridge is insufficient.  

5. Fixed a bug that caused the disk to be unable to be mounted if another process mounted the disk 

during the mounting process. 

6. Fixed a bug where the unmount process rarely failed. 

7. Fixed an issue where rollback using Utility could not be started in rare cases. 

 

Mac 

1. Optical Disc Archive Filer supports the function of transferring the entire volume of Optical 

Disc Archive cartridge to local storage on a Mac. 

2. Modified the Optical Disc Archive Filer so that even if the setting when transferring files or 

folders fails is set to " Discontinue immediately", It is available to transfer files to another 

cartridge when the remaining space of the cartridge is insufficient. 

3. Fixed a bug where the unmount process rarely failed. 

 * Optical Disc Archive Software doesn’t support Mac products with Apple silicon. 

 

Linux 

1. Support Red Hat Enterprise Linux 8.8 

2. Optical Disc Archive Utility has checked whether the transfer size of the Fibre Channel Host Bus 

Adapter card is appropriately set when starting up. 

3. Fixed a bug where the unmount process rarely failed. 

 

Drive Firmware 

Changes from V1.210 to V1.220 of ODS-D380U 

- Improved drive stability.  

-  

 Changes from V2.600 to V2.610 of ODS-D280U 

- Improved drive stability.  



 

 Note: 

  The Optical Disc Archive Software and the utility software may not recognize the unit("ODS-D380U") 

properly, 

  if the power of the unit is on, depending on the computer to which it is connected.  

  In this case, turn off the power of this unit, or disconnect the USB cable, and then start the 

computer. 

 

[Configuration of Computers Connected to the ODS-D280U, ODS-D280F, ODS-D380U, ODS-D380F] 

Please refer to the technical note "Recommended Configuration of Computers" which is combined together 

with ODS-D280U, ODS-D280F, ODS-D380U, and ODS-D380F. 

The technical note is also available from Sony Creative Software 

(http://www.sonycreativesoftware.com/). 

 

[Configuration of Computers Connected to the OLS-D500F] 

Please refer to the technical note "Recommended Configuration of Computers" which is combined together 

with OLS-D500F. 

 

[About the alarm code of ODS-D280U, ODS-D280F, ODS-D380U, ODS-D380F, OLS-D500F] 

 Do not update the firmware while the alarm is occurring. 

 After confirming that the alarm has been cleared by reinserting the cartridge or turning the drive 

power off / on, update the firmware. 

 If the alarm persists, contact your local Sony Sales Office/Service Center. 

 

 Cartridges with 6D-001 and 21-100 displayed in versions prior to V5.2.0 of Optical Disc Archive 

Software will be displayed 6D-002, 21-101 and 21-102 in V5.2.0 or later. 

 The contents of alarm codes 21-101, 21-102, 6D-002 and 91-556 and the error remedy method are as 

follows. 

 

 Code: 21-101 

 Description: Some media problem may have occurred. It is recommended to copy data to another cartridge. 

 Error remedy method: 

 1. Insert the cartridge. 

   Tip: If the alarm code 21-101 occurs again and the cartridge is ejected, re-insert the cartridge 

until the alarm code 21-102 occurs.  

The cartridge is mounted read only. 

 2. Copy the data to another cartridge . 

   Note: After the cartridge is ejected, if some media problem is detected when you re-insert the 

cartridge and access the data, the alarm code 6D-002 occurs. 

   Tip: For data transfer, use recover file or duplicate volume function of Optical Disc Archive 

Utility. For details, refer to Optical Disc Archive Utility help. 

 



 Code: 21-102 

 Description: This cartridge was mounted read only. It is recommended to copy data to another cartridge. 

 Error remedy method: 

 1. Since the cartridge is mounted read only, copy the data to another cartridge in this state. 

   Note: After the cartridge is ejected, if some media problem is detected when you re-insert the 

cartridge and access the data, the alarm code 6D-002 occurs. 

   Tip: For data transfer, use recover file or duplicate volume function of Optical Disc Archive 

Utility. For details, refer to Optical Disc Archive Utility help. 

 

 Code: 6D-002 

 Description: Some media problem may have occurred. It is recommended to copy data to another cartridge. 

 Error remedy method: 

 1. Insert the cartridge. 

 2. Insert again the ejected cartridge. 

 The alarm code 21-101 occurs and the cartridge is ejected. 

 Repeat this operation twice. 

 3. Insert again the ejected cartridge. 

 The alarm code 21-102 occurs and the cartridge is mounted read only. 

 4. Copy the data to another cartridge . 

   Note: After the cartridge is ejected, if some media problem is detected when you re-insert the 

cartridge and access the data, the alarm code 6D-002 occurs. 

   Tip: For data transfer, use recover file or duplicate volume function of Optical Disc Archive 

Utility. For details, refer to Optical Disc Archive Utility help. 

 

 Code: 91-556 

 Description: This cartridge was mounted read only. It is recommended to copy data to another cartridge. 

 Error remedy method: 

 1. Since the cartridge is mounted read only, copy the data to another cartridge in this state. 

    Tip: For data transfer, use recover file or duplicate volume function of Optical Disc Archive 

Utility or Optical Disc Archive Filer. For details, refer to Optical Disc Archive Filer help or 

Optical Disc Archive Utility help. 

    

 

[System Requirements] 

The supplied set of software has been tested and found to run under the following conditions. 

 OS: 

  ODS-D55U/ODS-D77U/ODS-D280U/ODS-D380U 

      Windows 

        Microsoft Windows 10 Pro 64-bit version 

 Microsoft Windows 11 Pro 64-bit version 

 Microsoft Windows Server 2016 

 Microsoft Windows Server 2019 



 Microsoft Windows Server 2022 

Mac 

macOS 11.7.9  

macOS 12.6.8  

macOS 13.5.2 

      Linux 

 Red Hat Enterprise Linux 7.9 64bit 

 Red Hat Enterprise Linux 8.6 64bit 

 Red Hat Enterprise Linux 8.8 64bit  

  

  ODS-D77F/ODS-D280F/ODS-D380F/OLS-D500F 

      Windows 

 Microsoft Windows Server 2016 

 Microsoft Windows Server 2019 

  Microsoft Windows Server 2022 

     Linux 

 Red Hat Enterprise Linux 7.9 64bit 

 Red Hat Enterprise Linux 8.6 64bit 

 Red Hat Enterprise Linux 8.8 64bit 

 

 CPU: 

       ODS-D55U/ODS-D77U/ODS-D77F 

            Intel Core 2 Duo 2.66GHz or Intel Xeon 2.0GHz or higher 

       ODS-D280U/ODS-D280F 

            3rd Generation Intel Core i5 2.5GHz or Intel Xeon 2.27GHz or higher 

       ODS-D380U/ODS-D380F/OLS-D500F 

     6th Generation Intel Core i5 2.3GHz or Intel Xeon 2.0GHz or higher 

      

 Memory: 

      ODS-D55U/ODS-D77U/ODS-D77F 

            2GBx(number of the units + 1) or more 

      ODS-D280U/ODS-D280F/ODS-D380U/ODS-D380F/OLS-D500F 

            4GBx(number of the units + 1) or more 

 

 Hard-disk space: 

      ODS-D55U/ODS-D77U/ODS-D77F 

            32GB + 16GBx(number of the units + 1) or more 

      ODS-D280U/ODS-D280F 

            32GB + 32GBx(number of the units + 1) or more 

      ODS-D380U/ODS-D380F/OLS-D500F 

            64GB + 64GBx(number of the units + 1) or more 

      



Interface: 

  ODS-D55U/ODS-D77U (USB) 

        Hi-Speed USB (USB 2.0): 

   Hi-Speed USB (USB 2.0) host controller required. 

        SuperSpeed USB (USB 3.2): 

   SuperSpeed USB host controller required. 

  ODS-D280U (USB) 

        SuperSpeed USB (USB 3.2): 

   SuperSpeed USB host controller required. 

  ODS-D380U (USB) 

        SuperSpeed USB 10Gbps (USB 3.2): 

   SuperSpeed USB 10Gbps (USB 3.2) host controller required. 

        SuperSpeed USB (USB 3.2): 

   SuperSpeed USB host controller required. 

 

  ODS-D77F/ODS-D280F/ODS-D380F/OLS-D500F (Fibre Channel) 

        Recommended Fibre Channel host bus adapters are as follows. 

 When using the QLogic host bus adapter on Linux, update the QLogic FC Driver to 

v10.01.00.53.07.6-k or later. 

 

  ODS-D77F： 

         QLE2560/QLE2562 (QLogic 8Gbps Fibre Channel Host Bus Adapter) 

         LPe12000/LPe12002 (Emulex 8Gbps Fibre Channel Host Bus Adapter) 

 

         ODS-D280F： 

         QLE2560/QLE2562 (QLogic 8Gbps Fibre Channel Host Bus Adapter) 

         QLE2690/QLE2692 (QLogic 16Gbps Fibre Channel Host Bus Adapter) 

         QLE2740/QLE2742 (QLogic 32Gbps Fibre Channel Host Bus Adapter) 

         QLE2770/QLE2772 (QLogic 32Gbps Fibre Channel Host Bus Adapter) 

         LPe12000/LPe12002 (Emulex 8Gbps Fibre Channel Host Bus Adapter) 

         LPe31000/LPe31002 (Emulex 16Gbps Fibre Channel Host Bus Adapter) 

         LPe32000/LPe32002 (Emulex 32Gbps Fibre Channel Host Bus Adapter) 

         LPe35000/LPe35002 (Emulex 32Gbps Fibre Channel Host Bus Adapter) 

 

         ODS-D380F/OLS-D500F： 

         QLE2560/QLE2562 (QLogic 8Gbps Fibre Channel Host Bus Adapter) 

         QLE2690/QLE2692 (QLogic 16Gbps Fibre Channel Host Bus Adapter) 

         QLE2740/QLE2742 (QLogic 32Gbps Fibre Channel Host Bus Adapter) 

         QLE2770/QLE2772 (QLogic 32Gbps Fibre Channel Host Bus Adapter) 

         LPe12000/LPe12002 (Emulex 8Gbps Fibre Channel Host Bus Adapter) 

         LPe31000/LPe31002 (Emulex 16Gbps Fibre Channel Host Bus Adapter) 

         LPe32000/LPe32002 (Emulex 32Gbps Fibre Channel Host Bus Adapter) 



         LPe35000/LPe35002 (Emulex 32Gbps Fibre Channel Host Bus Adapter) 

   

   

Note: 

These system requirements may not apply to all computers. 

 

---------- 

 

1. How to install the Optical Disc Archive Software 

 

Windows) 

(1) Before reinstalling the Optical Disc Archive Software, remove the Sony Optical Disc Archive 

Software by using the Add/Remove Programs tool in Control Panel and then restart your computer. 

(2) Unzip [ODASoftware_5_5_1_win.zip] and run [ODASoftware_5_5_1_win.exe], and follow the on-screen 

instructions to install both the Optical Disc Archive Software and Optical Disc Archive Utility. 

The settings return to default values. 

(3) Launch Optical Disc Archive Utility to check the version number of ODS-D55U/ODS-D77U/ODS-

D280U/ODS-D380U firmware and update it if necessary. Consult the service representative about the 

ODS-D77F/ODS-D280F/ODS-D380F/OLS-D500F firmware update. 

 

- The Optical Disc Archive Software may not function properly if the device is not assigned a drive 

letter in the range A-Z. 

 

Mac) 

(1) Unzip [ODASoftware_5_5_1_mac.zip] and run [ODASoftware_5_5_1_mac.dmg]. 
   Optical Disc Archive Software and utility software will be installed if you follow the instructions 

that appear in sequence. Depending on the dialog box displayed during installation, configure 

system software allows and full disk access settings (see the Optical Disc Archive Utility help 

guide). The user settings from the previous version will be inherited. 

(2) After completing the Optical Disc Archive Software installation, start the utility software and 
Please check the firmware version and update if necessary. 

 

Linux) 

(1) Unzip [ODASoftware_5_5_1_rhel.zip].  Open [ODASoftware_5_5_1_rhel.bin], and execute the install 

package. 

Follow the on-screen instructions to install the Optical Disc Archive Software and the utility 

software. 

 

(2) Once the installation of the Optical Disc Archive Software is completed, launch the utility 

software to check the version number of the device firmware and update it if necessary. Consult 

the service representative about the ODS-D77F/ODS-D280F/ODS-D380F/OLS-D500F firmware update. 

 



- If the Optical Disc Archive Software has not been installed to the computer, the computer may 

malfunction when connecting this unit. Install the Optical Disc Archive Software in advance before 

connecting this unit to the computer. 

  If an error occurred with the computer, shut down the computer and disconnect the unit. Restart the 

computer and install the software. Then, connect this unit to the computer. 

 

- Eject the cartridge before installing the Optical Disc Archive Software. 

 

- Installing the Optical Disc Archive Software and utility software overwrites a previous installation. 

Settings from a previous installation are preserved for the new installation. 

 

- If the Optical Disc Archive Software is uninstalled, the settings will have their default values 

when a new version of the Optical Disc Archive Software is installed. 

 

- If you need to re-install, uninstall the installed package according to the following procedure and 

then execute the ODASoftware_5_5_1_rhel.bin file. 

 

[How to uninstall RPM package] 

1. Check RPM package 

   >rpm -qa | grep odaudf 

    odaudf-utility-5.5.1-9.el6.x86_64 

    odaudf-5.5.0-9.el6.x86_64 

    odaudf-utility-gui-5.5.1-9.el6.x86_64 

2. Uninstall RPM packages by a user with root permission. 

   >rpm -e odaudf-utility-gui-5.5.1-9.el6.x86_64 

   >rpm -e odaudf-utility-5.5.1-9.el6.x86_64 

   >rpm -e odaudf-5.5.1-9.el6.x86_64 

- The following software must be installed when installing Optical Disc Archive Software. 

  apr 

  apr-util 

  bash 

  bzip2-libs 

  dbus-glib 

  fuse-libs 

  glib2 

  glibc 

  libgcc 

  libstdc++ 

  lsof 

  zip 

  pciutils 

  chkconfig 



  fontconfig 

  freetype 

  initscripts 

  libX11 

  libXext 

  libXrender 

  zlib 

 

(Compliant firmware version) 

  ODS-D55U:V1.300 

  ODS-D77U:V2.200 

  ODS-D280U:V2.610 

  ODS-D380U:V1.220 

 

2. Optical Disc Archive Software 

- The Optical Disc Archive Software Ver3.4.1 or before does not support to write the cartridge which 

is formatted on the Optical Disc Archive Software Ver4.0.0 or later. 

 The Optical Disc Archive Software must be upgraded to Ver4.0.0 or later to write the cartridge which 

is formatted on the Optical Disc Archive Software Ver4.0.0 or later. 

 

- Optical Disc Archive Software may not function correctly if installed alongside some antivirus 

packages, some anti-spyware tools. 

   

  The anti-virus software that has been tested on Windows is as follows. 

   

  Symantec 

   Endpoint Protection 14.3  

  Trellix（旧 McAfee） 

Trellix Endpoint Security 10.7 

McAfee Total Protection 16.0 

McAfee Security Center 19.21 

McAfee VirusScan Engine 5169.0(Version:26.6) 

  Microsoft Defender 

 

- Optical Disc Archive Software may not function correctly if installed alongside some products that 

contain OS non-standard UDF 2.5 or UDF 2.6 file system drivers. 

 

- ODS drive isn't rarely recognized even if a product contains OS standard UDF 2.5 or UDF 2.6 file 

system drivers. 

In such case, reinject the cartridge or reconnect ODS drive to the product. 

 

- It is not possible to power ODS-D55U/ODS-D77U/ODS-D280U/ODS-D380U through a USB cable. 



  The maximum number of units connectable to a PC is the following.  

 64bit systems: 4 units  

  Connections through a USB hub are not supported. 

 

- Recommended settings for PC 

Prevent computer from sleeping automatically when connecting ODS drive to computer. 

 Windows) 

1. Set thumbnail display of the explorer to off 

[Start] button > [Control Pane] > [Folder Options] > Mark the checkbox of [Always show icons, 

never thumbnails] on [Advanced settings] in the [View] tab, then click the [OK] button.2 

2. Power setting for PC 

[Start] button > [Control Panel] > [Power Options] > [Change when the computer sleeps] > Set 

[Put the computer to sleep] to [Never], then click the [Save changes] button. 

3. Set the USB selective suspend to off 

Select the active power plan from the pull-down menu of the [Start] button > [Control Panel] > 

[Power Options] > [Change plan settings] > [Change advanced power settings], set [On Battery] 

and [Plugged in] of [USB settings] > [USB selective suspend setting] to [Disabled], and click 

the [OK] button. 

  Mac) 

1. Set the icon preview of Finder to off 

Open the cartridge, select [Show View Options] from [View], then set [Show icon preview] to off. 

2. Set auto sleep of Macintosh to off 

     Select [Prevent computer from sleeping automatically when the display is off.] from [System 

Preferences] > [Energy Saver] in the Apple menu. 

 

- Memory capacity referred in "[System Requirements]" is required for the Optical Disc Archive 

Software. 

  When you run the Optical Disc Archive Software with the services or applications which need more 

memory, 

  Please consider the expansion of memory. 

 

- Don't support to share the Optical Disc Archive volume with multiple clients. 

 

- The KDE desktop environment is not supported on Linux. 

 

- A sparse file may not be recorded when using the cp command on Linux. In such a case, set the option 

"--sparse = never". 

 

3. Optical Disc Archive Utility 

 

- Starting 

Windows) 



  Install by selecting [Sony Optical Disc Archive Software]-[Optical Disc Archive Utility] from Start 

menu. 

Mac) 

  Install by selecting [Optical Disc Archive Utility] from Application or Dock. 

Linux) 

  Install by selecting [Optical Disc Archive Utility] from System tool of Application menu. 

 

 

- Firmware (ODS-D55U/ODS-D77U/ODS-D280U/ODS-D380U) 

    Eject the cartridge before updating the firmware. 

    Do not turn off the device, the computer and disconnect the USB cable during the firmware update. 

    When the firmware update is finished, the device must be turned off and on again. 

    The firmware version cannot be downgraded. 

 

- File Recovery Function 

    It is not guaranteed that any broken conditions will be recovered by the recover function in this 

software. 

  Note) 

   We have found that Windows versions of the Optical Disc Archive Utility prior to V5.5.0 may fail 

to repair files, or create files that are not properly repaired even though file repair is completed, 

only on the ODC5500R. Therefore, please use V5.5.0 or later version for ODC5500R file recovery. 

 

- Volume Check Function 

    The volume check function may not work when running the other operation. 

 

- Log export, File Recovery, Duplicate volume function 

    The device connecting network drive isn't supported. 

    Execute under the environment that supports zip command. 

 

4. Optical Disc Archive Filer 

 

- Starting 

Windows) 

  Install by selecting [Sony Optical Disc Archive Software]-[Optical Disc Archive Filer] from Start 

menu. 

Mac) 

  Install by selecting [Optical Disc Archive Utility] from Application or Dock. 

 

- About volume label 

Windows) 

  Up to 32 characters in Unicode 2.0. A surrogate pair counts as two characters. 

 



- Simultaneous connection number of ODS drive 

  Optical Disc Archive Filer can control up to four ODS drives simultaneously. 

 

 

- Restriction of file transfer  

  The file transfer to local volume from local volume and the file transfer in the same Optical Disc 

  Archive volume are forbidden.  

  In addition, when you transfer (retrieve) an entire volume of an Optical Disc Archive Drive to a 

local volume on PC, a folder is created on the transfer destination with a folder name which has a 

cartridge serial number appended. Note that if there is already a folder on a local volume of a 

computer with the same name as the volume name which has the cartridge serial number of the Optical 

Disc Archive Drive appended, you will not be able to transfer the entire volume of the cartridge. 

In this case, make changes such as appending _org to the end of the folder name that exists on the 

local volume, and then transfer the entire volume of the  Optical Disc Archive Drive to the local 

volume. 

 

- Data transfer to storage with LTO 9 data cartridge or SMB I/F (Windows Version Only) 

  Optical Disc Archive Filer version 5.5.1 has the function to transfer the data of the Optical Disc 

Archive cartridge to the data cartridge inserted in the UNITEX LTO-9 drive "LT90H" or the storage 

device with SMB I/F. supported. 

  Transfer from LTO 9 data cartridge to Optical Disc Archive cartridge and transfer from LTO 9 data 

cartridge to storage other than Optical Disc Archive cartridge are not supported. 

 

- A data archive from the FTP server to the Optical Disc Archive volume 

  Currently, the products listed below are tested. 

  XDS-PD2000 

  XDS-PD1000 

  PMW-1000 

  PDW-HD1550 

  PDW-HD1500 

  PDW-1500 

  PDW-HR1 

  SR-R1000 

 

---------- 

[Notes About Software] 

  - Content Manager 1.0 doesn't support ODS-D77U. 

  - Content Manager 1.0/2.0 doesn't support ODS-D77F. 

  - Content Manager 2.0.2/File Manager 2.2/Web Service for ODS 2.2 can't indicate version of Optical 

Disc Archive Software accurately in combination with Optical Disc Archive Software Ver 3.0.0/3.0.1. 

    In such case, version of Optical Disc Archive Software can be confirmed on Optical Disc Archive 

Utility. 



   

[Setting PC] 

    It is recommended to temporarily disable the following:  

    Resident programs such as antivirus and backup tools, or self-encrypting drive management services 

(e.g. Security management software for drives).   

 

  - Example problems 

      Archiving and retrieving files may not be successfully complete according to the version of TDM 

Service installed in a DELL workstation.  

      In such cases, try again the update. 

      If the update is still unsuccessful, try again with TDM Service disabled, or using another PC. 

       

------------------------------------------------------------------ 


